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INTRODUCTION 
Welcome! 
On behalf of the entire staff at Biblesoft, thank you for selecting PC Study Bible and 

welcome to the Biblesoft family. 

Using this Guide 
This QuickStart Guide is designed to do just that—give you a quick start in getting the 

most out of PC Study Bible. 

Each of the four sections focuses on one specific information area, so that you can 
quickly find the information you need, and readily apply it: 

 

 

 

 

 

 

 

  



SETUP 
The purpose of the Setup program is to properly install PC Study Bible onto your computer.  If 
you read this section and follow the step-by-step instructions given here, Setup should take no 
more than 5 minutes to complete— 

 
Step 1.  Insert the PC Study Bible CD into your CD-ROM drive. 
Simply place the CD (label side up) into the tray of your CD-ROM drive.  (Note:  This is 

an AutoPlay CD.  If the Setup program begins automatically, skip to Step 3, 
otherwise go on to Step 2.) 

 

Step 2.  Start the Setup program. 
If AutoPlay started the Setup program go on to Step 2.  Otherwise, click on the Start 

button (located at the bottom left corner of your screen), then click on the Run 
option… 

 

Step 3.  Choose where the program files will reside. 
The PC Study Bible program files must reside on your hard drive, the question is—where 

on the hard drive?  Setup will recommend C:\PCSTUDY.  You should only 
change this setting if necessary.  (For example, perhaps you have two hard 
drives on your system and drive C is nearly full.  In that case you might specify 
D:\PCSTUDY.) 

 

Step 4.  Choose where the reference work files will reside. 
Unlike the program files (which must reside on your hard drive), the reference work files 

can reside on the hard drive or on the CD.  In fact, it is usually preferable to 
have a few of these files on the hard drive, with the balance on the CD. 

The most important thing to know about this part of the setup process is that you can 
easily change this configuration later on.  (A program called Module Manager 
will be placed in the program group along with PC Study Bible and will let you 
revisit, and modify, this portion of Setup any time you desire.) 



There are three things to consider in determining which reference work files you want on 
the hard drive and which you want on the CD: 

1. SPACE.  Any files you copy from the CD to the hard drive will consume 
space there—perhaps quite a bit if you copy everything. 

2. SPEED.  The hard drive is much faster than the CD, so any files placed there 
can be retrieved and searched faster than on the CD. 

3. CONVENIENCE.  Sometimes you may want to run PC Study Bible without 
having the CD in the drive (perhaps because you’re listening to a music 
CD).  So, it is important to know that PC Study Bible requires at least one 
Bible translation in order to run.  That means that at least one Bible 
translation must be copied to your hard drive if you want to be able to run 
PC Study Bible without the CD. 

 

We recommend that you copy every Bible translation in which you will commonly do 
concordance searches onto your hard drive.  For example, many people use the 
New American Standard today, but grew up doing their Bible memorization in 
the King James Version.  They would copy both translations, in anticipation of 
concordance searches in both. 

In addition, you should copy all of the index files for all of the reference works onto your 
hard drive.  This will reduce access time, even though the reference works 
themselves will still be on the CD. 

It is probably not necessary, nor extremely beneficial, to copy any additional reference 
materials to your hard drive at this time.  Later, if you find that you are spending 
a great deal of time in a particular work and wish to reduce the access time, you 
can use Module Manager to copy additional reference works onto your hard 
drive. 

Note:  Module Manager also allows you to “copy” reference works back onto the CD. 
(That is, those works are deleted from your hard drive and PC Study Bible 
makes a note to access them from the CD.) 

 

Step 5.  View the README file for last minute notes and errata. 
The README file contains a great deal of information that is not covered within this 

manual, including macros for your favorite Windows word processor and any 
last minute information that did not get included here.  You should take a quick 
look at it now, even if only to find out what types of information it contains. 



 

Step 6.  Complete and mail us your registration card. 
Finally, we encourage you to complete and mail us your registration card.  This is our 

only link to you, our customer, and we value that connection.  We will use that 
information to contact you as additions and enhancements are made to the PC 
Study Bible library—either additional reference works or new program 
capabilities.  And we will not provide that registration information to any other 
company. 

 

That completes the Setup process.  PC Study Bible is now fully installed and ready to run. 

We encourage you to glance through the following section—A Basic Bible Study—to get a feel 
for how to get the most out of PC Study Bible.  (Even if you’ve used PC Study Bible 
before, you’ll find some new and useful features!) 

And you might want to glance at the Unlocking section (beginning on page ) so that you are 
familiar with the ability to instantly add additional reference works to your Bible study 
library through a simple phone call! 

 



A BASIC BIBLE STUDY 
The purpose of this section is to guide you through a typical Bible study.  Along the way, you will 

learn the fundamental concepts that will help you get the most out of PC Study Bible. 
Even if you have used PC Study Bible before you will still want to browse through this 
material, as many new and exciting features have been introduced to make your Bible 
study time easier and more productive! 

Step 1.  Open a Bible 
Whenever you know precisely where you want to go in a reference work (e.g., a specific 

verse reference in the Bible, or a particular topic in an encyclopedia), the easiest 
way to get there is to use the Open buttons on the main toolbar. 

 

 

 

 

 

 

Each of the Open buttons represents a type of reference work.  There is one button each 
for—Bibles, Commentaries, Encyclopedias (all things organized by topic), 
Dictionaries (all things organized by English word), Interlinear, Strong’s 
definitions, Maps, Photos, Treasury of Scripture Knowledge (a category unto 
itself), and Books (all things that don’t fit any other category!). 

 

 

 

 

 

 



For this Bible study, select Genesis 7:11—the beginning of the Flood.  (For those of you 
who are trivia-minded, this is the first mention of “Windows” in the Bible. 
Perhaps Microsoft owes some royalties to God!) 

 

Step 2.  Copy to the Clipboard 
 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Step 3.  Cross-reference 
It is important to understand what we mean by a cross-reference.  A cross-reference is a 

link from one reference work type to another type, using the current “key.” 



Several examples should help to illustrate this definition.  From a Bible passage—in this 
case, Genesis 7:11—you might cross-reference to the interlinear Bible for 
Genesis 7:11 or to commentary materials for Genesis 7:11.  Likewise, from a 
map focused on Bethany, you might cross-reference to photos of Bethany or 
encyclopedia articles on Bethany. 

Notice how the current “key” (“Genesis 7:11” and “Bethany” in the examples above) is 
used to find information in other reference work types that are organized in a 
similar fashion.  Bibles, interlinear Bibles, and commentaries are organized by 
book-chapter-verse, while maps, photos, and encyclopedias are organized by 
topic. 

Just about every reference work type has the ability to cross-reference to other types. 

 

 

 

 

 

 

 

 

This is a good time to tell you about Biblesoft’s appendable Clipboard.  Briefly, the 
Clipboard is shared by all Windows programs to support cut and paste 
functions—either within a program or between programs.  Typically, each item 
you copy to the Clipboard replaces the previous item.  However, Biblesoft has 
extended that functionality so that you can copy multiple items, without 
overwriting the previous item(s).  That way, you can copy a whole set of Bible 
references and/or study materials, then paste the entire set into your word 
processor whenever you’re ready. 

There are two things you can do with items that you copy to the Clipboard.  First, you can 
paste them into a study note within PC Study Bible.  We’ll examine that action 
in more detail in Step 9, Making a Study Note, beginning on page .  Second, 
you can paste them into your word processor.  For that reason, it is often useful 
to have both PC Study Bible and your favorite word processor running at the 
same time.  Use the Windows Start | Programs menu to begin both programs. 



Then switch between them by clicking on their respective buttons on the 
Windows taskbar. 

 

 

 

 

 

Step 4.  Switch between windows 
Just as Windows allows you to have multiple programs open and running at the same 

time, PC Study Bible also lets you have multiple reference work windows open 
and running at the same time.  This is identical to having your Bible, and several 
other reference works, set out on a table—with each one open to a specific 
passage. 

Another way of looking at this is that each time you open a new window in PC Study 
Bible the previous window(s) are still on the desktop, and available for your use. 
There are three ways to switch to one of the other windows on the PC Study 
Bible desktop: 

 

1. The simplest way is this:  if you can see a portion of the desired window, 
click on it.  That will bring it to the “top” or “front” of your desktop. 
Otherwise, 

 

 

 

 

3. Click on the Window menu item.  A list of all open windows will be 
displayed at the bottom of the Window menu.  Click on the menu option of 
the desired window to jump directly to it.  This is the quickest method of 
returning to a particular window when you have half a dozen or more 
windows open. 

 

 



 

 

 

To continue with this Basic Bible Study, use the Previous Window button to return to the 
Bible window. 

 

Step 5.  SmartReference™ 
One of the most powerful ways to find related information in your PC Study Bible library 

is Biblesoft’s exclusive SmartReference™ capability.  When you 
SmartReference™ you are, in essence, asking PC Study Bible to display a 
summary list of every piece of information in an entire reference work type that 
references the information you are currently viewing. 

Let’s take a look at two examples: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

2. Let’s view a second example of the SmartReference™ capability.  Return 
to the Interlinear Bible window—by clicking on it (if you can see any 
portion of it), or by using the Previous Window and/or Next Window 
buttons, or by selecting it from the list at the bottom of the Window menu 
option. 
 
Next, double-click on Strong’s #1234 (just above the phrase “were broken 
up”).  You have just “cross-referenced” from the Interlinear Bible to a 
Strong’s definition. 

 

 

The 
value of this form of SmartReference™ action is that PC Study Bible has 
just listed every Strong’s definition that refers to the current Strong’s 
number.  In some cases the word is derived from the current word, or vice 
versa, while sometimes a comparison (how are they the same) or contrast 
(how are they different) is being made between the two words. 

A similar SmartReference™ action is from Strong’s definition to Commentary. 
Simply open a Strong’s definition then click on the SmartReference™ to 
Commentaries button, located on the local toolbar.  Remember that any 
time a SmartReference™ button is “lighted” it indicates that one or more 
reference works of that type have information specifically relating to the 
current verse, topic, Strong’s number or whatever else you are studying.  No 
searching.  No wandering down blind alleys.  Automatically! 

 

Step 6.  View related materials 
Naturally, multiple reference works of the same type (e.g., Bibles or encyclopedias) may 

have information for the same “key”.  For example, every New Testament Bible 
version has a verse for John 3:16.  In the same way, most every Bible 
encyclopedia has article information for Pentateuch. 

 

 



 

 

 

 

 

Step 7.  Paste to a Word Processor 
There are two methods for copying materials from PC Study Bible into a word processor 

document, or even into a Bible study note within PC Study Bible (see Step 9, 
beginning on page , for more information about Bible study notes). 

 

 

 

 

 

 

 

Each of these actions places a copy of the selected material on the Windows Clipboard, 
which is shared by all Windows programs for copy and paste functions.   Once 
the material has been copied onto the Clipboard you can paste it into a word 
processor document, into a study note within PC Study Bible, or into any other 
Windows program that supports the paste function. 

In its normal operation, the Clipboard can only hold one copied item at a time—each time 
you copy an item it replaces the current item on the Clipboard.  PC Study Bible 
extends that capability so that you can copy multiple text items to the Clipboard 
without “copying over” the previous item.  We call this feature the appendable 
clipboard.  (Note:  You are still limited to one graphical item, map or photo, on 
the clipboard at a time). 

 

 

 

 



Remember that Windows allows you to have multiple programs running at the same time. 
That means you can have your word processor and PC Study Bible running at 
the same time, and switch between them (either by clicking on the Windows 
task bar located at the bottom of the screen or by pressing Alt+Tab). 

 

Step 8.  Search 
{Search Bible text} 

 

Step 9.  Make a Study Note 
{Attach a Study Note} 

 

 



 

AUTHORING 
One of the most exciting features of PC Study Bible is the ability to create your own 

reference works.  The ability to create and maintain a personal commentary is 
built directly into PC Study Bible.  This commentary can have all of the features 
of every other commentary in the PC Study Bible library system: 

● search text, 

● embed Bible, topic, and Strong's numbers references to support 
cross-referencing to other reference works, and 

● SmartReference™ from Bible text to your personal commentary 

● view in a Commentary window, in a Study Notes pane in a Bible, or 
both 

● specify order of preference, and more 

 

In addition, your commentary has the added value of being a “living” 
document—meaning that you can modify it any time you want. 

There are 4 steps to creating a personal commentary:  Step 1 is done once.  Steps 2 
through 4 are repeated whenever you want to change your commentary: 

STEP 1 Name your commentary. 

STEP 2 Go to a specific passage in your commentary 

STEP 3 Modify your commentary. 

STEP 4 Save your changes. 

 

 



Step 1—Name Your Commentary 
The first step in creating your commentary is to name it.  You will do this once (and only 

once) for each commentary you wish to create.  All of your personal study notes 
should be kept in a single commentary.  You should only need to create one or 
more additional commentaries if other members of your family desire to 
maintain their own personal commentary, or if you are compiling another, 
non-personal commentary (e.g., sermon notes or an old, classic commentary). 

You may want to keep this Help window open while you go through the following 
procedure: 

● On the PC Study Bible menu bar, select Options, then select 
Preferences. 

● Click on the References tab. 
 
 
 
 

● In the Author field, type your name.  Then use the Tab key (or the 
mouse cursor) to move to the Short Copyright field. 

● The Short Copyright is used whenever material is copied from PC 
Study Bible to the Windows Clipboard.  A typical copyright notice 
would be “Copyright 1998 © <your name here>.  All rights reserved.” 
You can also leave this field blank.  Type the desired copyright then 
Tab to the Full Name field. 
 
To enter a copyright symbol (©), hold down the Alt key, press 0169, 
then release the Alt key. 

● The Full Name of the reference work is sometimes used when 
somebody is making a selection from a list of available reference 
works.  This field cannot be left blank.  Type the complete name of 
your commentary then Tab to the Short Name field. 

● The Short Name of the reference work is also the most commonly 
used name.  It will appear in most reference work lists, as well as in the 
Reference Work Edit box when you are viewing that reference work. 
This field cannot be left blank.  Type the short name of your 
commentary.  The short name is required since it is also used as the file 



name for your new reference work. 
 
The Copyright tab is used to describe a full copyright page, much 
as appears in a printed book.  This is typically reserved for a reference 
work that will receive wide distribution.  For detailed information on 
defining a full copyright page reference the PC Study Bible online help 
system (Help | Authoring). 
 
Likewise, the Title Page tab is used to recreate the title page from a 
printed book.  For detailed information on defining a title page 
reference the PC Study Bible online help system (Help | 
Authoring). 

● Click the OK button to create your Commentary or click the CANCEL 
button to leave the Create a New Reference Work dialog 
without creating a new Commentary.  If you selected OK, then your 
Commentary will be created and will appear in the list of available 
reference works in the Commentary Window. 

 

 

  



 
Step 2—Go to a Specific Passage 
The second step is to go to a specific passage in your commentary. 

The following instructions assume that you have already created and named a personal 
commentary reference work.  If you have not yet done that, please return to Step 
1 (beginning on page ). 

To go to a specific passage in your commentary: 

● Open a Commentary Window by clicking on the {bmc 
C:\HELP\Ver30\BITMAPS\ICONCOMM.BMP} button (located on 
the Main Toolbar) or by selecting Bookshelf | Commentaries... 
from the menu. 

● In the Verse Reference Dialog, specify the desired book, chapter, and 
verse and select your personal commentary (by its name) in the 
Reference Work box. 

 
Note:  If no commentary has been created at that reference yet, you will be warned and 

given the opportunity to go to that reference anyway or to cancel the open 
commentary action.  The warning dialog contains a check box that enables you to stop 
that warning message from being displayed each time you go to a new, or 
“uncommentated,” reference.  Check that box (by clicking on it) if you do not want 
the warning message to appear again. 

● If you will be adding an article that applies to the entire Bible book, 
click on the Book tab in the Commentary Window.  Or, if the article 
applies to an entire chapter, click on the Chapter tab.  Otherwise, you 
will be adding commentary that applies to a single verse or a number of 
consecutive verses and you should already be on the Verse tab. 

 
At this point the Commentary Window should be at the precise reference where you 

intend to add your new commentary material. 
 

 

  



Step 3—Modify Your Commentary 
 

The third step in creating a personal commentary reference work is to make changes to 
your commentary.  When making changes you can add content, change existing 
content, and/or delete content. 

 

 

 

 

The simplest way to create new commentary is to type it (or paste it from the Clipboard) 
directly into the edit window.  However, your commentary will become far more 
useful with the addition of formatting and embedded references.  “Formatting” 
describes how the content will be appear (font, size, color, margins, and so 
forth).  “Embedded references” provide access to and from other reference 
works in your PC Study Bible library via SmartReference™ and 
cross-references. 

Formatting and embedded references are added using “tags”.  While this may sound 
technical, it isn't.  Let's look at an example.  The following text is from a 
personal commentary, attached to the book of 1 John: 

When Moses wrote, “In the beginning God...” (Genesis 1:1) he was writing purely under 
the influence of the Holy Spirit. But when John takes up the pen in this letter, 
he is writing both under the influence of the Holy Spirit and from personal 
experience. 

In formatting this portion of text, the author wanted to emphasize the words “both” and 
“and”.  This is done by applying any one of the text styles that are defined in PC 
Study Bible.  In this case, the Emphasized text type satisfies the need.  (You 
can view a complete list of all available text styles, and their attributes, by 
selecting the Options | Text Styles menu item in PC Study Bible.)  The 
<BTT:> tag (short for “BEGIN_TEXT_TYPE”) is used to mark the beginning 
of the formatted text and to specify a text style, while the <ETT> tag (short for 
“END_TEXT_TYPE”) marks the end.  Hence, 

When Moses wrote, “In the beginning God...” (Genesis 1:1) he was writing purely under 
the influence of the Holy Spirit. But when John takes up the pen in this letter, 



 

he is writing <BTT:Emphasized>both<ETT> under the influence of the Holy 
Spirit <BTT:Emphasized>and<ETT> from personal experience. 

This text also contains a reference to Genesis 1:1, which would be “tagged” as follows: 

When Moses wrote, “In the beginning God...” (<BIBLE:Genesis 1:1>) he was writing 
purely under the influence of the Holy Spirit. But when John takes up the pen 
in this letter, he is writing <BTT:Emphasized>both<ETT> under the influence 
of the Holy Spirit <BTT:Emphasized>and<ETT> from personal experience. 

This commentary text is now completely “tagged.”  When it is saved, PC Study Bible 
will convert or “compile” the tags.  When the commentary text is next viewed, 
the formatted text will appear with whatever attributes you have assigned to the 
Emphasized text type (italics, by default) and you will be able to double-click on 
the Genesis 1:1 reference and instantly bring up that Bible text.  Furthermore, 
this portion of your commentary will become available as a SmartReference™ 
from Genesis 1:1! 

The following tags will be useful in creating your personal commentary.  You will find 
detailed information about them, along with tips for effectively using them, in 
the PC Study Bible Help system: 

 <BIBLE:> to indicate an embedded Bible reference, which can then be 
used to access the corresponding Bible text. 

 <TOPIC:> to indicate an embedded topical reference, which can then be 
used to access the corresponding Encyclopedia articles. 

 <STRONGS:> to indicate an embedded Strong's number reference, which 
can then be used to display the corresponding Strong's definition(s). 

 <BTT:>  <ETT> for marking portions of text as a particular text type. 

 <PARAGRAPH:> for marking paragraphs as a particular paragraph type. 

 <TAB> to insert a tab character. 

 

The next, and final, step is to save your changes. 

 

  



Step 4—Save Your Changes 
Any time you modify your commentary you will need to save your changes. 

 

 

 

 

 

Note:  To abandon any changes that you have made, and return your commentary to its 
previous state, simply click the close window icon (at the top right corner of the 
Commentary Pane) to exit edit mode, without saving your changes. 

You can make changes to your personal commentary at any time. 

 



 MORE INFORMATION 
For information about using PC Study Bible: 

 
● Within the PC Study Bible program, press the F1 key to get On-line Help for any screen, 

button, dialog box, or function.  Or, from the PC Study Bible menu, select Help | Help. 
 

● If you can’t find the answer in the On-line Help system, please contact our Technical 
Support staff in any of the following manners— 
 
    E-mail us at techsupp@biblesoft.com, or 
 
    Call us at (206) 824-0547, or 
 
    Write us at: 

 
Biblesoft 
Attn:  Technical Support 
22014 7th Ave. So. 
Seattle, WA  98198 
USA 

 
● If you believe that you have a defective CD, wish to unlock additional reference works on 

your CD, or have other product-related questions, please contact our Customer Services 
staff in any of the following manners— 
 
    E-mail us at custsrvc@biblesoft.com, or 
 
    Call us at (206) 824-0547, or 
 
Write us at: 

 
Biblesoft 
Attn:  Customer Services 
22014 7th Ave. So. 
Seattle, WA  98198 
USA 
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